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PRESIDENT’S CORNER

Welcome Back!
I hope everyone had a safe and happy
summer. It’s been a long HOT summer, so it’s
time to come in a cool off at the PC.

September 8th Meeting – Office 2010

Now that Office 2010 has been released,
we will have a demonstration of the full product.
Please let me know if there are particular program
(there are a lot) or feature that you would like to
see demonstrated or emphasized.
I’m going to try to hit the high-lights at the
meeting as it is a lot to go over. I will also only
have time to cover a few of the biggies (Word,
Excel, PowerPoint) but as I stated earlier, let me
know if there are some features that you would
like to see.

October 13th Meeting – Social Networking

Many of you may already be on some of
the social networks out there (Facebook, MySpace,
etc.) but many have had questions as to what it’s
all about. At our October meeting we will cover
these topics.

November 10 Meeting – Windows 7 SP1
It will most likely be a non-event for most
Windows 7 users, but this fall the first Service
Pack for Windows 7 will be released. If you have
been keeping up on your Windows updates (You
BETTER BE) then the changes will hardly be
noticeable.

December 8th Meeting – Holiday Party!

Last year’s Holiday Party will be tough to
top, but the committee is busy at work on planning
this year’s event. Let us know what you would
like to see presented.

I hope to see you at the upcoming meetings!

Michael

Hot to do a Windows 7 Upgrade
by
Fran Damratowski

When upgrading your computer the first thing you
need to know is the capability of your computer. Is
it ready for Windows 7?  The easiest way to find
out is to use the Windows Upgrade Advisor http://
windows.microsoft.com/en-US/windows/downloads/upgrade-advisor. The upgrade advisor will
tell you which of the Windows 7 product editions
you can upgrade to and the hard ware and programs that will run on Windows 7. Be sure to follow the instructions such as plugging in your USB
devises for example your printer and scanner. You
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can also check the Windows 7 requirements http://
www.microsoft.com/windows/windows-7/get/
system-requirements.aspx and http://windows7.
windowsreinstall.com/systemrequirements.

Are you planning to use the 32 bit (x86) or the
64 bit (x64) version of Windows 7?  Compare the
two versions http://windows.microsoft.com/en-us/
windows7/32-bit-and-64-bit-Windows-frequentlyasked-questions.   If you are planning to use the 64
cont’d on Page 10
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Soluto - cont’d

An interesting choice on the Soluto icon
is “My PC just frustrated me”, which opens
the Soluto window, and analyzes the running
processes, and tries to determine which program
is causing the slowdown. Any information found
during the “frustration” analysis is anonymously
added to the Genome where it will be comingled
with other data and potential solutions may be
determined. If a solution to the “frustration”
exists, it looks like it will be displayed to the user.
When I clicked on the “Frustration” menu item,
Soluto identified the beta version of a new security
product that I am testing as the potential source of
“frustration” but could not yet show any remedy
to my “frustration”.
While Soluto is still in the “beta” stage
of development, I found it a very useful and
worthwhile utility to improve PC performance,
particularly in the boot process, and for resolving
potential “frustrations”. Users should give
Soluto Anti-Frustration Software a try. In my
limited experience with it, I would give it my
recommendation, as well as a rating of “two
thumbs up”.
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Soluto Anti-Frustration Software Improves Boot Time
by
Ira Wilsker

WEBSITES:

http://www.soluto.com
http://blog.soluto.com
http://www.soluto.com/About/Media-Kit

In several past columns I have written
about utilities that can speed up the computer
boot process. As cluttered as it was, my old XP
machine could take up to five minutes to boot; my
newer Windows 7-64 machine boots in under two
minutes, considering the multilayered security
that is installed on it. Traditionally, the ways of
speeding the boot process on a PC was to defrag
the hard drive, and clean up the programs in the
startup that load when the computer is first turned
on. When someone tells me that his computer
takes forever to boot, my typical responses are “is
your hard drive defragged” (defragmented), and
“how many little icons do you have on your task
bar adjacent to your clock?”. There are several
excellent startup managers available (including
Windows ‘msconfig” feature), both independent
utilities and components of utility suites, that
can easily control what programs load at boot.
Simply unchecking unwanted and unnecessary
programs at boot is an accepted way of improving
boot time. Likewise, there are several excellent
defragmentation utilities available, including
the simple one built into Windows, that can do a
credible job; by defragging the hard drive, it does
not have to work as hard when reading files and
data, thus providing some improvement in load
times.
While these two methods are well accepted
and proven to speed up the boot process, a new
concept in utilities was recently released that goes
an extra step in controlling the boot process using
a software “genome” and community experiences
to determine what is loading in the computer at
boot, how long each item takes to load, displays
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what is required or optional to load at boot, and
gives the user control of what loads and when
it loads during the boot process. Wanted, but
low priority items, can be set to load after the
computer has fully booted, and is sitting idle,
thus not degrading the boot process. Unwanted
items can be stopped from automatically loading,
but set to load upon demand. The process may
sound complex, but it is very simple with the
information provided by this new utility, “Soluto
Anti-Frustration Software (beta)”.
Available as a free download from www.
soluto.com, this software is a “beta” or pre-release
version, which by definition, is not a highly
refined final “release” version.  My 18 month old
“new” computer booted very quickly when new,
but now that I have a lot of security software
and other utilities loading at boot, it was taking
between a minute and a half, and two minutes to
boot. After I downloaded and installed Soluto,
and rebooted the computer such that Soluto
could measure and analyze my boot process, my
first modification of my boot process improved
my boot time by almost 25%!  Subsequent
refinements of my boot process with Soluto, and
input from the “community” have helped me to
shave off about another 10% of my boot time.
After being installed, Soluto monitors what
loads at each boot. During the boot process, the
bottom left corner of the desktop turns up like
the corner of a page and displays each item as
it is loading, while displaying the elapsed time
to boot the computer. Information is gathered
during the boot process, and added to what has
been gathered at previous boots, to provide
the data that is analyzed by the program. The
data that is collected is anonymously added to
the Soluto PC Genome, where the community

cont’d on Page 4
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Soluto - cont’d
can input recommendations that will assist the
user in determining what can be controlled at
boot. According to Soluto, “ This anonymous
technical data is gathered and sent to Soluto’s
PC Genome, a one of a kind knowledge base
containing statistical insights about PC software
and hardware behavior, as well as remedies
to alleviate PC usage frustrations. By putting
this information into the light, the PC Genome
will help consumers and vendors alike. Soluto
employs another set of innovative algorithms to
determine which remedies will have a positive
impact on each Soluto user’s unique PC system.
These remedies are then shared with other relevant
Soluto users.” Soluto has found that by pausing
when specific items load in the boot process, and
reconfiguring some of the applications, boot time
and overall behavior of the computer can improve
dramatically. Soluto can also determine those
programs that degrade computer performance,
and provide the “frustrated” user with possible
solutions to reduce or eliminate the source of
frustration.
Soluto places a small icon on the task
bar that looks somewhat like a smiley-face,
and opens displaying the Soluto functions. By
opening Soluto anytime after the computer has
booted, the first screen called the “Boot Page”
displays “Potentially Removable” items in
an orange font, along with the boot time and
sequence for each. By moving the cursor over
any of the “Potentially Removable” items, a brief
description of the software is displayed (if it is
in the Genome). By moving over the “more” on
the display, a recommendation may be shown,
as well as a pie chart of what other users of that
software have done. The user is given the option
to “Pause” or “Delay” the item in subsequent
boots. “Pause” prevents the item from being
loaded at boot, but the program can still be loaded
upon demand; “Delay” postpones the selected
program from automatically loading until the
4
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computer is otherwise idle, which means that
it will not slow the initial boot process. Since
Soluto (beta) has just been released, the genome
is still in its infancy, and does not yet contain a
comprehensive database of software. The user can
easily click on the pencil icon “edit” and open a
Wiki which enables the user to “fill in the blanks”
about an item, which will then be verified, and
added to the Genome. As more users complete
the Wiki, the Genome database will become more
complete. As the Genome improves through this
community input, all of the users can benefit by
the dissemination of the information.
The grey section of the main screen
“Boot Page” in Soluto displays the “Required
- cannot be removed” items that load at boot,
in their boot sequence and with their boot time
displayed. While most of the items shown are
valid Windows components, with an explanation
of what each does along with its boot time, some
of the items are non-Microsoft files, and lack
detailed descriptions.  When I first used Soluto,
the components of my MagicJack VoIP service
(internet based telephone service) were listed as
“Required”, and could not be paused or delayed;
I opened the Wiki and explained what they were,
and then commented that I thought that these
particular components should be moved to the
“Potentially removable” section where their boot
process could be better managed. As the Genome
grows and improves, items like this will be better
sorted into the appropriate category.
The blue section on the “Boot Page” shows
the items that were “Paused’ or “Delayed” at boot,
and how much time was saved by not loading
those items. Clicking on any blue item gives the
user the choice of changing the status to boot,
“Pause” or “Delay”, which will be implemented
the next time the computer is booted.
cont’d on Page 2
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MS Excel Tips

Counting Cells with Specific Characters

Let’s say that you have a Microsoft Excel
worksheet that contains all the people who have
ever worked in your department. Each name is
prefaced by a single character that indicates the
status of the person. For instance, if Fred Davis
were retired, his name might show up as “RFred
Davis”. With quite a lot of these names in the
worksheet, you may need a way to count those
people with a specific status character.
The easiest way to accomplish this is to use
the COUNTIF function. If, for instance, the status
character is the letter R (for “retired”), and your
range of names is in cells A5:A52, then you could
use the following to determine which cells begin
with the letter R:
=COUNTIF(A5:A52,”R*”)
The formula works because the comparison
value is R*, which means “the letter R followed
by any other characters.” Excel dutifully returns
the count. To search for a different status
character, simply replace R with the desired status
character.
Obviously, if the asterisk has a special
meaning in this usage, you can’t search directly
for an asterisk. Actually, there are three characters
you cannot search for directly: the asterisk (*), the
question mark (?) and the tilde (~). If you want
to search for any of these characters, you must
precede the character with the tilde. Thus, if you
wanted to determine a count of names that had a
question mark as a status code, you could use the
following:
=COUNTIF(A5:A52,”~?*”)

most character of a cell, returning the value TRUE
if it is R or FALSE if it is not. The multiplication
is done to convert the TRUE/FALSE value to a
number, either 1 for TRUE or 0 for FALSE. The
SUM function returns the sum, or count, of all the
cells that meet the criteria.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by
permission. Thousands of free Microsoft Excel tips can be found
online at http://excel.tips.net.

Indenting Cell Contents

Microsoft Excel allows you to format the
contents of a cell in a myriad of ways. One of the
formatting options you can apply is to indent the
contents of a cell by a certain amount. This is similar
to indenting done in a word processor, such as
Microsoft Word, except that the indenting is specified
in a number of characters, not in a linear distance
such as inches or points.
To set the indent to be used in a cell, follow
these steps:
1. Select the cells you want to format.
2. Display the Format Cells dialog box. (In Excel
2007 display the Home tab of the ribbon and
click the small icon at the lower-right corner of
the Number group. In older versions of Excel
choose Cells from the Format menu.)
3. Make sure the Alignment tab is selected.

An alternative to using COUNTIF is to create
an array formula that is applied to every cell in the
range. The following will do the trick very nicely:
=SUM((LEFT(A5:A52,1)=”R”)*1)
This must, of course, be entered as an array
formula. This means that instead of pressing
Enter at the end of the formula, you would press
Shift+Ctrl+Enter. The formula checks the left-

The Alignment tab of the Format Cells dialog box.

cont’d on Page 6
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cont’d from page 5

Indenting Cell Contents - cont’d
4.

In the Horizontal drop-down list, choose Left
(Indent). If you are using Excel 2002 or a later
version, you can also choose Right (Indent).

5.

Using the Indent control, specify the number of
characters by which the cell contents should be
indented from either the left or right side of the
cell. You can pick any whole number between 0
and 15.

6.

Click on OK.

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by
permission. Thousands of free Microsoft Excel tips can be found

Defining Shortcut Keys for Symbols
Defining Shortcut Keys for Symbols

When you need to insert a special symbol
into a cell, the normal way to do it is by using the
Insert Symbol dialog box. If you need to insert
the same symbol quite often, you may want a way
to assign the symbol to a shortcut key so you can
insert it easier.
Some symbols have obvious shortcut keys,
defined by the folks in Redmond. One of the
lesser-known facts is that every symbol has a
“shortcut” key, but using that shortcut may not
seem that short. How does this work? By holding
down the Alt key as you type the ASCII or ANSI
code for the symbol.
For instance, let’s say you want to enter the
cents symbol. If you display the Insert Symbol
dialog box and select the cents symbol, at the
bottom right of the dialog box you can see the
character code for the symbol (it is 00A2). This is
a hexadecimal number; you need to convert it to
regular decimal notation. You can do this by using
the formula =HEX2DEC(“00A2”), which returns
the value 162. If you remember this code, you can
hold down the Alt key as you type the code, with
a leading zero, on the numeric keypad.
This approach works great if you only need to
input a few symbols on a regular basis; it doesn’t
take much work to remember those few codes
you need. However, if you have a lot of symbols

you need to work with, then remembering codes
becomes more problematic. You could develop
your own printed “cheat sheet” for the symbols so
that you can refer to it all the time, or you could
rely on Excel’s AutoCorrect feature to do the
remembering for you. Follow these steps:
1. Use the Insert Symbol dialog box to insert
the symbol into a cell.
2. Select the cell that contains the symbol.
3. Press F2 to start editing the cell.
4. Select the symbol, and only the symbol.
5. Press Ctrl+C to copy the symbol to the
Clipboard.
6. Display the AutoCorrect tab of the AutoCorrect
dialog box. (In Excel 2010 display the File tab
of the ribbon, click Options, click Proofing,
and then click AutoCorrect Options. In
Excel 2007 click the Office button, click
Excel Options, click Proofing, and then click
AutoCorrect Options. In older versions of
Excel choose AutoCorrect options from the
Tools menu.)

The AutoCorrect tab of the AutoCorrect dialog box.

7. In the Replace field, type a short mnemonic
for the symbol. This should be a series of

6
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Defining Shortcut Keys for Symbols - cont’d

cont’d from page 6

letters that are not a real word, such as hrt, which might be the mnemonic for a heart symbol.
8. In the With field press Ctrl+V to paste the symbol from the Clipboard.
9. Make sure the Formatted Text radio button is selected.
10. Click OK.
Now you can just type the mnemonic when you want the symbol to appear. When you type the space
bar after the mnemonic, AutoCorrect kicks in and replaces it with the symbol.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found online at http://excel.tips.net.

MS WordTips
Inserting a Non-Breaking Hyphen

When Microsoft Word calculates line length
and wraps text to the next line, it tries to wrap (or
break) the line at a space or a hyphen—a dash.
Sometimes, however, you may not want Word
to break a line at a dash. For instance, dashes are
used in telephone numbers, and you might not
want a line to break in the middle of a telephone
number.
The answer is to use non-breaking hyphens
instead of regular dashes when you don’t want
Word to break a line at the hyphen. To do this,
hold down the Ctrl and Shift keys as you type
the dash (this is the same as typing Ctrl and an
underscore). Word will then not break the line at
that point.
You can also insert a non-breaking hyphen by
following these steps:
1. Choose Symbol from the Insert menu or,
in Word 2007, display the Insert tab of
the ribbon, click Symbol in the Symbols
group, and finally click More Symbols. This
displays the Insert Symbol dialog box.
2. Click on the Special Characters tab.

The Special Characters tab of the Symbol dialog box.

3. Highlight the Nonbreaking Hyphen
character.
4. Click on Insert.
5. Close the dialog box by clicking on Cancel.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission.
Thousands of free Microsoft Word tips can be found online at http://word.
tips.net.

cont’d on Page 8
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MS WordTips - cont’d
Printing More Than One Copy
Microsoft Word gives you complete control
over how it prints your document. If desired, you
can print more than one copy of your document.
To print to a file, follow these steps:
1. Choose Print from the File menu. You will
see the Print dialog box. (To display the Print
dialog box in Word 2007, click the Office
button and then click Print.) A really quick
way to display the Print dialog box is to
simply press Ctrl+P.

The Print dialog box.

2. In the Copies box, indicate the number of
copies you want to print.
3. In the Range box, specify what you want to
print.
4. Check the status of the Collate option. (Select
or clear the option based on whether you want
the pages of each copy printed in order or not.)
5. Click on OK.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by
permission. Thousands of free Microsoft Word tips can be found

Slowing Down Mouse Selection
Have you ever noticed that there are times
that text scrolls way too fast on your screen when
you are trying to select it using the mouse? There
are many ways you can attempt to slow down the
speed at which text scrolls when you are using
the mouse to select text. Perhaps the easiest is to
use the keyboard in conjunction with the mouse.
You do this by clicking the insertion point at the
position where you want the selection to start,
and then hold down the Shift key while you click
where you want the selection to end.
However, if you don’t want to use the
keyboard, and only rely on the mouse, your
options are a bit more limited. Perhaps the best
idea is to get a mouse that has a scrolling wheel
between the two buttons. Using the wheel you can
scroll through a document at the speed you want.
Those who have used Word for a while
know that there are actually two mouse-scrolling
speeds in Word. To use the slower speed when
selecting text, move the mouse down to the
horizontal scrollbar area. This scrolls downward
at a relatively moderate speed. Moving the mouse
below the horizontal scrollbar sends the scrolling
into full-speed mode. The “moderate speed” zone
for scrolling upward is the ruler bar. The actual
differences between these scroll speeds depends
on the speed of your computer and how many
other tasks your system is running.
The final option to try is to slow down the
mouse speed using Windows itself. Display the
Control Panel, and then open the Mouse applet.
(How you access both the Control Panel and the
Mouse applet will vary, depending on your version
of Windows.) Within the Mouse applet, make
sure the Motion tab is displayed. You can adjust
the Pointer Speed setting on this tab so it is more
toward the Slow side. When you close the applet
by clicking on OK, you should notice that your
mouse speed is a bit more manageable.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by
permission. Thousands of free Microsoft Word tips can be found
online at http://word.tips.net.
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from the Secretary’s desk
Minutes from the August 25th, 2010 Board of Directors Meeting
Attendees:  The Mikes Young, Regimenti, DeLuca, Fran Damratowski, Kathy Walker, Craig Barlow,
and  Kris Johnson

Meeting Topics:

September Meeting – Office 2010 presented by Mike Young
October Meeting – Social Networking presented by Mike Young
November Meeting – Windows 7 Service Pack 1 presented by Mike Young.  Fran Damratowski will do a
mini presentation of Windows Anytime Upgrade (Fran’s article can be found on page 1 of this issue)

SIGS:

Technology: Mike Regimenti will give a presentation of Suluto
MSCUG – The CRSIG will visit MSCUG on October 21.  (The board will conduct its monthly meeting on
the way to Easton)
CRSIG – The refurbishing center is still conducting its business on a month to month basis. There are no
new developments about what plans are in progress for the Crownsville property.  Fran reported that 2031
computers have been refurbished to date. She had questions about what the center’s insurance was for the
year.  Kathy said that she would look into it.  There was some discussion about plans for a celebration of
the completion of 2000 refurbished computers but no final decision was made.
Mike DeLuca said that he would set up a PDF for computer applications on the web site so that applicants
could send in a completed application via e-mail. The submission of the e-mail would be the applicant’s
way of acknowledging that they had read and accepted the terms of the application.

Finances

The treasurer reported that the club is solvent.  Kathy stated that the club’s non-profit status was in good
standing.

NEW BUSINESS:

Mike Regimenti said that he is having problems getting out the newsletter but that he will do his best to
get one out before the next meeting. Most likely the newsletter will j=have to be in B&W.
Kris brought up the possibility of giving each donor to the refurbishing center a personalized “thank you”
letter but it was decided that it would be too time consuming.
Fran showed the Board a sample of the shirt that she had purchased but stated that there had been comments that it lacked a shirt pocket so she is looking into other options.
Mike Young asked Fran if she could go to the International Conference on Computer Refurbishing in Chicago. She will look into the possibility of her going.
Meeting was adjourned at 9:15 p.m.
Kris Johnson, Secretary
THE PRINTER
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Windows 7 Upgrade - cont’d

bit version you need a 64 bit processor. The easiest way to find out which processor you have on
your computer is to use device manage. You can
do so by right clicking “My Computer” then left
clicking “Properties”. You can also run BeLarc
Advisor http://www.belarc.com/free_download.
html, or CPU-Z http://cpuid.com/ to get information about your computer. Once you know which
processor you have you have you can to go to the
manufacturer’s website to checks the specification
of your processor for example Intel at http://www.
intel.com/products/processor/index.htm or AMD
at http://www.amd.com/us/products/pages/processors.aspx. While you are there check to see if
your processor is capable of virtualization in case
you want to run Windows XP.

The next thing you will want to check are the drivers for your peripherals such as your printer and
scanner. You can go to the Microsoft Compatibility Center http://www.microsoft.com/windows/
compatibility/windows-7/en-us/default.aspx. If
you do not find you hardware or software listed go
to the manufacturers/publishers websites to see if
drivers are available for the hardware and updates
for the software. Some manufactures or publishers may not have updates for Windows 7, but the
Vista version may work. Do an on line to see if
the Vista version of the drivers will work with
Windows 7.  If you cannot find drivers or update
for the 64 bit version see if they are available for
the 32 bit version.  If the 32 bit version is available and you want to keep your older peripherals
you will then need to install the 32 bit version of
Windows 7.
Some software programs will not run under Windows 7. If you have a favorite program that will
not run under Windows 7 you can install Windows
XP mode which runs under virtualization http://
windows.microsoft.com/en-us/windows7/installand-use-windows-xp-mode-in-windows-7.

Now that you know that you can upgrade to either
the 64 bit or the 32 bit Windows 7 it would be a
good idea to backup any files you wish to save to
an external hard drive, DVD, CD, or flash drive.
This will be a great time to clean out all those old
files you no longer need or just want to archive on
a CD/DVD. Gather the programs you will want to
install after you upgrade to windows 7 be sure you
have any product licenses that will be needed. If
you can’t find the product licenses print a copy of
BeLarc Advisor before you attempt the upgrade.
Look for software licenses.  All of your files and
programs should be intact if you upgrade from
Vista or another edition of windows 7. It’s better
to be safe than sorry.
Now you need to decide which of the windows
7 product editions to install. You can compare
the different product editions to determine which
product edition meets your needs http://windows.microsoft.com/en-us/windows7/products/
compare?T1=tab15 .
Be sure to click on the tabs for more information
about the different of Windows 7 product editions.
You can also find more information about the different product editions by doing a web search for
a comparison of the different Windows 7 product
editions.
If you have a computer with either Vista or Windows 7, the easiest way to upgrade is to use “Windows Anytime Upgrade”. Windows Anytime
Upgrade can be found in the Control Panel. If
your Control Panel is set to “Category”, change it
to “Large Icons” by clicking on “View by.” The
list is arranged alphabetically.
To upgrade click on “Windows Anytime Upgrade” you will be asked to enter your product
ID key (5 groups of 5 numbers and letters of the
alphabet) follow the directions on the screen.
Be sure to click on the upgrade button in the
lower right corner.  It will take about 10 minutes.
All of your programs and files should be intact.                         
cont’d on Page 11
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Windows 7 Upgrade - cont’d
The reason it happens so quickly is that all product editions of all Windows 7 are actually on your
computer you are simply activating the upgrade.
If you do not already have any products ID keys
you can purchase a copy of the Windows Anytime
Upgrade product ID (not the full product) either in
a retail store or online. Any valid ID product key
will work if you already have one it is not necessary to purchase another one. A number of websites related to anytime upgrade are listed at the
end of this article.
If you are upgrading from Windows XP to Windows 7, you will need to do a clean install. Here it
is important to find your product IDs for any software that you which to reinstall and to save your
files.  Microsoft has published a tutorial to help
you make the transition. PRINT THE TUTORIAL AND FOLLOW IT EXACTLY.
http://windows.microsoft.com/en-us/windows7/
help/upgrading-from-windows-xp-to-windows-7.
If you have a netbook you would like to upgrade
to a higher version of Windows 7, you need to
consider the fact that netbooks are bare bones
computers. Most use the Intel Atom processor
that is limited to 2 GB of RAM, most are sold
with 1 GB of RAM, and it doesn’t have an optical
drive. If you should choose to upgrade Microsoft
comes through again with some help http://windows.microsoft.com/en-us/windows7/installingwindows-7-on-a-netbook and http://store.microsoft.com/Help/ISO-Tool
DO NOT PLACE A FULL VERSION DISK
OF WINDOWS 7 IN YOUR COMPUTER
AND INSTALL IT OVER THE TOP OF A
PREVIOUS VERSION OF YOUR OPERATING SYSTEM. It will create confusion. You will
have duplicate copies of your files that will require
much work to clean up and some files will not be
in the correct folder or library.
If you are interest in more information before you
begin, check out the websites listed below be sure
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to click on all of the tabs and links of all of the
websites listed in this article. The websites are a
virtual treasure.
http://www.microsoft.com/windows/windows-7/
default.aspx
http://windows.microsoft.com/en-US/windows7/
upgrading-to-windows-7-frequently-asked-questions
http://windows.microsoft.com/en-us/windows7/
Installing-and-reinstalling-Windows-7
http://windows.microsoft.com/en-us/windows7/
help/upgrading-from-windows-vista-to-windows7-custom
http://windows.microsoft.com/en-US/windows7/
help/getting-started
http://windows.microsoft.com/en-US/windows7/
help
http://en.wikipedia.org/wiki/Windows_Anytime_
Upgrade
http://www.microsoft.com/windows/windows-7/
get/anytime-upgrade/find-your-edition.aspx
http://windows.microsoft.com/en-US/windows7/
Upgrade-to-another-edition-of-Windows-7-byusing-Windows-Anytime-Upgrade
http://windows.microsoft.com/en-US/windows7/
products/features/windows-anytime-upgrade
https://profile.microsoft.com/Regsysprofilecenter/
subscriptionwizard.aspx?wizid=f5186ad1-5ab84bde-971b-e6d9b074aaaa&lcid=1033
NB Club members in good standing can bring their
club flash drives to the next club meeting and down
load a copy of the websites in this article so they can
just click on them rather than typing them.
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ChPCUG dues are $40 per year

www.chpcug.org/

The Next Regular Meeting will be at
The Severn River Middle School

Wednesday
September 8th, 2010
Meeting will be held in the large meeting room.
It starts at 7:00 P.M. with club business
and a short discussion period.

presentation on

MS Office 2010
by

Michael Young
Members and their friends are welcome to
come, ask questions and become enlightened.

1783 Forest Drive #285
Annapolis, MD 21401

How to Find: Severn River Middle School
SRMS is close to the Arnold, MD campus of the
Anne Arundel Community College. From Annapolis
and points south, take Rte 2 (Ritchie Highway) north
about 3 miles from the intersection of Rt. 50, turn right
on College Parkway.  At the first light, turn left on
Peninsula Farm Road. (Of course, if you are coming
from points North, you would turn left onto College
Parkway) about a half-mile down the road the large
SRMS school building, set back off a large two level
parking lot, will be visible on your right. Park here
and go to the main entrance. Signs will be posted to
direct you to the Large Group Room where we will
be meeting.
How to find: The Technology SIG, A ChPCUG
Special Interest Group**
The meetings are held at the SRMS in the Library.
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